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Introduction

PRODUCT SUMMARY

The Central Management Software allows multiple
medication storage devices to be managed from a central
location. The software uses a network connection to
communicate with devices on the local network. It allows
user logs to be downloaded, aggregated across devices, and
saved to a locally stored database. The software also allows
remote management of device settings, such as user access
permissions, bin names, and operational settings.

SYSTEM REQUIREMENTS

e The Central Management Software must run on a
Windows PC

e The software requires about 30MB of storage for the
program plus additional storage for the local database.
The size of the database will vary depending on usage.

e The PC must have a network connection to communicate
with the medication storage devices on the network.

e Any device managed by the software must also be
connected to the local network.

e Continuous network connection is not necessary for the
software or devices. A network connection is only needed
when the software tries to communicate with the devices.
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GETTING STARTED

SOFTWARE INSTALLATION

Please visit www.altus-inc.com/manuals to download the

Central Management Software Installer. Double click the
install file to begin the installation.

Follow the onscreen instructions to choose the installation
location and options. The default installation location is the
current Windows user’s personal directory.

The Central Management Software may now be launched
through the start menu or desktop shortcut, depending on
the options chosen during the installation.

USING THIS MANUAL

We strongly recommend reading this manual in its entirety
before using the software. The manual is organized into the
following sections:

I. Introduction — The current section provides general
information on the software, installation, and this
manual.

Il. Overview of the Software — This section explain how
data is structured, stored and loaded in the Central
Management Software and connected devices. It
provides an important background for the sections that
follow.

Ill. Using the Software — This section explains how to
configure the software and conduct specific operations,
such as loading and saving data and updating devices.

IV. Appendix — The appendix provides additional
information, such as the specific information that is
stored in each database table.
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Overview of the Software

DATABASES AND COMMUNICATION

! Device A Database :
Logs from Device A :
Settings for Device A

Bin Names for Device A '
User Permissions for Device A |

! Device B Database :
Settings for Device B
Bin Names for Device B
User Permissions for Device B

_________________________________________

Logs from Device B CENTRAL
A |\ ANAGEMENT
‘ SOFTWARE

LOCALLY STORED DATABASE

Load Bin Names

i Device C Database !
Logs from Device C >
Settings for Device C '
Bin Names for Device C 1
User Permissions for Device C |

_________________________________________

Save
Device A DeviceAl Device A DeviceA}
Device B Device Bl Device B Device B}
Device C Device Cl Device C Device C}

COMMUNICATION

The Central Management Software runs on a PC and serves as
the communication hub between connected devices and a
locally stored database. The software communicates with
medication storage devices through a local area connection.
The locally stored database can be kept on the PCor a
network folder. Each medication storage device maintains its
own database.

The software can download logs and settings from connected
devices. Once downloaded into the software, logs and
settings can be saved to a locally stored database for future
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use. To view previously saved data, logs and settings can be
loaded from the locally stored database.

Any settings that are downloaded or loaded into the Central
Management Software can be used to update connected
devices. For instance, a list of users can be loaded from the
locally stored database and then used to update the users on
one or more connected devices.

Establishing Communication

The PC running the software and the remote devices must be
on the same local network. Review the user manual for your




device for information on connecting your device to the local
network.

To establish a connection to a device, the network address
for the device must be added to the device list. See “List of
Devices” on page 7 for more information on establishing a
network connection between the Central Management
Software and your devices. It is recommended that
connected devices are assigned a static IP address or
preferably a unique hostname. Consult with your network
administrator about networking questions.

DATABASES

Locally Stored Database

A locally stored database serves as the data repository for the
Central Management Software. This data file stores all
information related to the Central Management Software,
including the list of connected devices (see “List of Devices”
on page 7).

Multiple database files can be created and used to segregate
data. For instance, a separate database can be created for
each department within a facility. However, only one
database may be open at any time. If multiple databases are
used, always ensure the desired database is open when using
the software.

The “Database Location” option in the Settings menu shows
the currently loaded database file (see “Database Location”
on page 7). The file shown in that option will serve as the
current database, from which data may be loaded or saved.
The database may be stored on a network folder so that it
can be backed up or made visible to other computers.

EE Local Data Location | = ” (=] ||i3-|

QSQLITE *

C:/Department_Database. sglite Browse...
Mew Database ... Cancel

The section titled “Managing Locally Stored Data” on page 10
explains how to load and save data form the local database.
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Device Databases

Each connected device maintains its own database, which is
used to configure settings, determine user access
permissions, and record user access logs of that device.

A device’s database does not contain information about other
devices. However, elements of a database can be replicated
across devices through the Central Management Software. In
other words, each device can be configured to operate
independently (i.e. different user access, bin names, settings,
etc.) or multiple devices can be configured to operate the
same.

See “Managing Data Stored on Devices” on page 8 for
information on downloading and updating data on connected
devices.

DATA TABLES

Data that is downloaded from devices or loaded from the

local database appears in windowed tables in the Central

Management Software (see the examples below). Data is

displayed in separate tables for each device and each data
type (Settings, Logs, Users, Bins).

Bins from local for 192.168.240.51 | = || B |[n25s]

Bin Number Bin Type Bin Name

0 Supplies Supply Bin

1 Maormal Meds Bin 1

2 Mormal Meds Bin 2

3 Mormal Meds |m

4 Mormal Meds  Bin 4

5 Marmal Meds Bin 5

] Mormal Meds Bin 6

Add a new ane Delete the selection

To edit a field in a table, double click on the entry you'd like
to modify. Enter the new information and press “enter” on
your keyboard. To save changes to the local database follow
the instructions in “Saving Data to the Local Database” on
page 10. To update a device with changes, follow the
instructions in “Updating Devices” on page 9.



Table Titles

The title of each table window describes the type of data and
source of the data. The title distinguishes data that is
downloaded from devices and data that is loaded from the
local database as shown below:

Data downloaded from a device

Title Format: “DATA TYPE from NETWORK ADDRESS”
Example: “Bins from 192.168.240.51”

Bins from 192.168.240.51 =% Ech 5=
BinNumber  Bin Type Bin Name
0 Supplies Supply Bin

Data downloaded from the local database
Title Format: “DATA TYPE from local for NETWORK ADDRESS”
Example: “Bins from local for 192.168.240.51”

Bins from local for 192,168.240.51

= o ==

Bin Number Bin Type Bin Name

0 Supplies Supply Bin
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THE MENU SYSTEM

The menu system provides the list of command and options
in the Central Management Software. It is categorized into
the following sections:

Central Management Software

File Manage Devices Settings  Window Help

o File — Provides options for loading and saving data to the
local database. Also provides an option for exporting data.
See “Managing Locally Stored Data” on page 10.

e Manage Devices — Provides options for downloading data
from connected devices and updating those devices with
new settings. See “Managing Data Stored on Devices” on
page 8.

e Settings — Provides options for connecting to devices and
selecting a local database file. The options in this menu
should be configured prior to using other options in the
software. See “Configuring the Software” on page 7.

e Window — Provides options for organizing and navigating
open windows within the program (see below).

o Help — Displays information about the Central
Management Software.

The Window Menu

The windows menu has four options as shown below:

File Manage Devices Settings | Window Help
Tile

Cascade

Mext

Previous

“Tile” and “Cascade” organize open windows within the
program. “Tile” organizes the windows into a tiled pattern,
while “Cascade” stacks the windows in a staggered pattern.

“Next” and “Previous” allow navigation through open
windows. “Previous” will display the previously opened
window and “Next” will display the next window.
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Using the Software

CONFIGURING THE SOFTWARE

The Settings menu provides options for modifying the list of
connected devices and selecting the local database file. It is

important to properly configure these settings prior to using
other functions of the software.

File Manage Devices = Settings  Window  Help
List of Devices

Database Location

DATABASE LOCATION

Choose “Database Location” from the Settings Menu to view
the location of the currently open database. You may also
open another database or create a new database from this
window (see instructions below). For more information on
the local database system, see “Locally Stored Database” on
page 4.

Local Data Location | = ” (=] ”&|
QSGLITE -
C:/Department_Database. sglite Browse...

Mew Database ... Cancel

Create a New Database
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To create a new database file, press the “New Database”
button. In the next dialog box, browse to the desired folder
location. Enter a new database name and click “Open” to
create it. Ensure that the correct database file is displayed in
the Local Data Location window. The Local Data Location
window may now be closed.

Open an Existing Database

To open an existing database, press the “Browse” button. In
the next dialog box, browse to the database file you’d like to
use. Click open. Ensure that the correct database file is
displayed in the Local Data Location window. The Local Data
Location window may now be closed.

LIST OF DEVICES

Edit Device List = = £Z
Metwork Address
192.168.240.61
192.168.240.11%

local.Roomd31

Add a new one Delete the selection

Choose “List of Devices” from the Settings menu to view and
modify the list of connected devices. Each device is listed by
its Network Address (IP address or hostname). For
convenience, we recommend giving each device an intuitive
hostname, so it can easily be identified in the list (for example
“Room231” on the list above. Consult the user manual for
your device to determine how to set the host name.




To add a device to the list, click “Add new one”. A new entry
entitled “DEFAULT” will be added. Double click on the name
“DEFAULT” and type the network address of the new device.
Press enter on your keyboard to complete the process.

To delete a device, select the desired network address by
clicking on it. Press “Delete the selection”.

Static IP and Hostname

Routers and access points often assign IP address
dynamically, which means that the IP addresses on your
devices could change over time. This could prevent the
Central Management Software from communicating with
your device if the IP address changes. Therefore, it is
recommended that a constant network address is
established for each device. This can be accomplished by
either assigning static IP addresses to your devices or
assigning a hostname for each device.

Your network administrator may be able to assign a “static IP
address” to the cabinet that does not change over time.
Contact your network administrator for more details.

Alternatively, each device can be assigned a unique hostname
that is discoverable on the network. To assign a hostname,
consult the user manual for your device. Contact your
network administrator to determine how to identify a device
by hostname on your network.
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MANAGING DATA STORED ON DEVICES

The “Manage Devices” menu provides options for
downloading information from connected devices and
updating devices with new information. The options are
described below.

File = Manage Devices Settings Window Help
Download Logs
Download Settings
Update Devices

DOWNLOADING LOGS FROM DEVICES

To download logs from one or multiple devices, choose
“Download Logs” from the Manage Devices Menu. A series of
dialog boxes will guide you through the steps of downloading
logs.

When prompted, select a device or multiple devices from
which you wish to download logs. To select multiple devices,
the following shortcuts may be used. This information also
appears in the “Help” section of the selection dialog box.

< Load Lags from Device

Choose the data source(s)

Device

192.168.240.116

192.168.240.51

Finish Cancel Help

e To select all devices, press “CTRL” and “A” together on
your keyboard.

e To select multiple devices, hold “CTRL” on your keyboard
while selecting devices with your left mouse button. This
method may also be used to deselect devices from a
current selection.

e To select a range of devices, select the first device in the
desired range. Next, hold “Shift” on your keyboard while
clicking on the last device in the desired range.



When all of the desired devices have been selected, click
finish to begin downloading the logs. A progress bar will show
the progress of the download process. If multiple devices are
selected, the logs will be aggregated into a single table.

See “Log Table” on page 13 for more information on user
logs.

After selecting the options you'd like, press “Finish”. The
selected data will be loaded into individual tables. The data in
these tables may be edited as described in the “Data Tables”
section on page 5.

DOWNLOADING SETTINGS FROM DEVICES

Device settings are stored on each device. These settings
configure behavior of each device. A specific device’s settings
may be downloaded for viewing, editing, or saving.

To download device settings, choose “Download Settings”
from the Manage Devices Menu. A series of dialog boxes will
guide you through the steps of downloading settings.

When prompted, select a device or multiple devices from
which you wish to download settings. To select multiple
devices, use the shortcuts described in “Downloading Logs
from Devices” section on page 8. This information also
appears in the “Help” section of the selection dialog box.
Press “Next”.

< Load Settings from Device

Choose the Device(s) to Load

Metwork Address

102.168.240.116

192.168.240.51

MNext Cancel Help

On the next screen, choose the data you wish to load. There
are three options:

L Loed Setting: from Deice

Choose settings to load

EA Bne
B Settings
EA Umars

e Bins — Loads bin names and bin types
e Settings — Loads settings that control device operation

e Users — Loads a list of users and their access rights
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UPDATING DEVICES

Any opened data table can be sent to a device in order to

update the data on that device. For instance, when a new

user is added from the Central Management Software, the
user table can be updated on all devices.

WARNING: Updating a device with any particular data table
will replace the existing data table on that device. For
instance, if a new list of users is saved to a device, it will
replace the previous list of users.

To update a device (or multiple devices), choose “Update
Devices” from the Manage Devices menu. A series of dialog
boxes will guide you through the steps of updating devices.
When prompted, choose the data tables that you would like
send to your devices. Press “Next”.

« Save to Device

Choose the data to save

Warning: Saving the selected data will replace previously existing data in the local database for the selected devices.
Check Al

Bins from local for 192.168.240.51

Settings from local for 192.168.240.51

Users from local for 192,168,240.51

On the next screen choose the devices that you would like to
update with your selected data. To select multiple devices,
use the shortcuts described in “Downloading Logs from
Devices” section on page 8. This information also appears in
the “Help” section of the selection dialog box. Press “Finish”
to complete the update process.

<« Save to Device

Choose the destination Device(s)

Network address

192.168.240.51

Finish Cancel Help




MANAGING LOCALLY STORED DATA

The File Menu provides options for managing data in the local
database and exporting data to separate file. The options are
described below.

File Manage Devices Settings  Window  Help

Load Legs From Database
Load Settings from Database
Save to Database

Export Data

Exit

SAVING DATA TO THE LOCAL DATABASE

User logs and device settings can be saved as a backup or for
future use. For instance, logs downloaded from devices can
be saved for future viewing. Or a list of users can be saved to
the local database to serve as the master list of users. When
needed, the list can be modified and can be used to update
devices (see “Updating Devices” on page 9).

WARNING: Saving a data table to the local database will
replace and existing data table in the database. However,
data tables saved to the local database are always separated
by device name. For instance, if logs from multiple devices
are saved to the local database, the logs will be separated by
device in the database. Logs that already exist in the local
database for any particular device will be replaced with the
new logs for that device.

To save data to the local database, choose “Save to
Database” from the File menu. A series of dialog boxes will
guide you through the steps of saving data. When prompted,
choose the data tables that you would like save to the local
database. Press “Save” to complete the update process.

LOADING LOGS FROM THE LOCAL DATABASE

To load logs that were previously saved to the local database,
choose “Load Logs From Database” in the File Menu. A series
of dialog boxes will guide you through the steps of loading
the logs.

When prompted, select the device logs you wish to load. To
select multiple devices, use the shortcuts described in
“Downloading Logs from Devices” section on page 8. This
information also appears in the “Help” section of the
selection dialog box. If multiple devices are selected, the logs
will be aggregated into a single table.

L Load Logs from Local Database

Choose the data source(s)

Device
TO2.168.240.116

162.168.240.51

When all of the desired devices have been selected, click
finish to begin downloading the logs. A progress bar will show
the progress of the download process.

See “Log Table” on page 13 for more information on user
logs.

< Save to Local Database

Choose the data to save

Warning: Saving the selected data will replace previously existing data in the local databaze for the selected devices.
Chedk All

Bins from local for 192,168,240.51

Settings from local for 192,168, 240.51

Users from local for 192,168.240.51

Save Cancel
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LOADING SETTINGS FROM THE LOCAL DATABASE

To load previously-saved settings from the local database,
choose “Load Settings from Database” from the File Menu. A
series of dialog boxes will guide you through the steps of
loading settings.

When prompted, select a device or multiple devices from
which you wish to download settings. To select multiple
devices, use the shortcuts described in “Downloading Logs
from Devices” section on page 8. This information also
appears in the “Help” section of the selection dialog box.
Press “Next”.

10



<« Load Settings from Local Database

Choose the Device(s) to Load

Network Address

192.168.240.51

default

On the next screen, choose the data you wish to load. There
are three options: Bins, Settings, and Users as described in
“Downloading Settings from Devices” on page 9.

EXPORTING DATA

Opened data may be exported to a CSV (comma-separated-
values) file. This function is useful for exporting data into a
format that can be loaded into spreadsheets and other
software programs.

To export data, choose “Export Data” from the File menu. A
series of dialog boxes will guide you through the steps of
exporting data. When prompted, choose the data tables that
you would wish to export. Press “Next” to continue. A dialog
will appear allowing you to choose the location and name for
the exported file.

€« Load Settings from Local Database

Choose settings to load

| Uncheck Al
Eins

Settings

Users

After selecting the options you’d like, press “Finish”. The
selected data will be loaded into individual tables. The data in
these tables may be edited as described in the “Data Tables”
section on page 5.
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Output 'Bins from 192.168.240.116' X
« v 4 g » ThisPC » 0S(CH) v|®| | Search05(C) P
Organize = New folder == ~ [ o

~

[ Desktop ~ Name Date modifie ®

|| Documents SWINDOWS.~BT

* Downloads Dell

B Music Drivers

&=| Pictures Hotfix

B videos inetpub

Intel
» i, 05(CY e
RECOVERY M U
File name: v| Spreadsheet (*.csv ") ~

After choosing a file name and location, press “Open” to save
the file.

IMPORTANT NOTE: Each data table selected will be exported
into a separate file. The current table being exported is
displayed in the titled block of the files selection window. This
information is boxed in the above image. A detail of the
information is shown below for clarity.

Output 'Bins from 192.168.240.118'

“ « ARG » ThisPC » 0OS(C)
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Section IV

Appendix

DATA TABLE FIELDS BINS TABLE

The bins table displays the bin number, the bin type and the
This section describes the “fields” that exist in each data table bin name. Only bin type and bin name are editable. Bin
type (Settings, Bins, Users and Logs). Fields are holding places number 0 is included for devices that contain supply storage

for specific information as described below. . .
P areas and will only affect such devices.

SETTINGS TABLE Double clicking on bin type reveals a pull-down menu of
options. The bin type may limit access for specific user types

The settings table includes information that controls . . . “
& as explained in your device manual (see “Other Manuals and

ti f a device:
operation of a device Software” on page 14).

e CanOpenAll — Controls whether a icon appears on the
device to enable all bins to be opened at once. “true” Bins from 192.168.240.116 | = || =& || &2
enables the button and “false” disables it.

¢ Timeout — The time in seconds before the device Bin Number Bin Type Bin Mame
automatically relocks. 0 Supplies Supply Bin
e Version — Displays the firmware version of your device. 1 Narmal Meds Bin 1
This setting is provided for reference only and cannot be _
changed on the device. 2 Mormal Meds Bin 2
3 Mormal Meds Bin 3
Settings from 192,168.240.. = | & | £ | 4 Nermal Meds  Bin 4
5 Mormal Meds Bin 3
Setting Value .
& Mormal Meds Binf
CanQpenAll true
Timeout a0 Add a new one Delete the selection
Version 591
Add a new one Delete the selection
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USERS TABLE

The users table displays the users that have access to a device
and includes the following columns:

e PIN - Unique numeric identifier and access code for a
user. This PIN code must be kept confidential to prevent
unauthorized use of a device.

e Name — The unique text name for a user

¢ Enabled — Determines whether a user has access to the
device. “Yes” grants user to access the cabinet. “No”
disables the user and prevents access to the device.

e User Type — Provides selection of user type through a
drop-down menu. User type will affect a user’s access
rights within a device as explained in your device manual
(see “Other Manuals and Software” on page 14).

o Temporary User Expires — Sets a user to expire at a future
time. Enter the desired expiration date and time in this
field. After the expiration date, the user will be disabled
(i.e. Enabled will be set to “No”).

Users from 192.168.240.116 o || =] &R
PIM Mame Enabled User Type Temporary User Expires
10397 Factory Ad.. Yes Admin
1234 ). Smith Yes Murse

Add a new one Delete the selection

To add a new user, press “Add a new one”. Next, edit the
fields for the new user as desired. To delete a user, select the
desired user and press the “Delete the selection”. It is
generally recommended that users are disabled rather than
deleted for better record keeping.
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LOG TABLE

The log table displays information regarding user access to a
device. It displays who has accessed contents of the device,
who has modified device settings, and who has modified user
settings.

If logs are loaded from multiple devices, the logs will be
aggregated into a single table and sorted by date. When an
aggregated log table is saved to the local database, the logs
are separated by device. This allows selection of which
devices to include in a log table each time one is loaded from
the local database (see “Loading Logs from the Local
Database” on page 10).

The table below describes the information included in the log
table.

Heading Indicates... Examples

Shows the device name set
for your device

Device | The device name

Network | The network IP address or hostname
Address | identifier for the

device

User Name or “System” for
automated activities (i.e.
during startup).

User Name | Who performed
the activity

User ID | The PIN code for
the user

Activity | What was done e Lock / Unlock / Logout

e ChUser (a user was added
or modified)

o ChSettings (a setting was
modified)

Item | The item that was Bin Number, Cassette, or
affected. Supply Door

Description | Details of the e Name of bin that was
activity accessed

e Modification made to user
account

o Description of setting that
was changed.

e Startup events and any
errors

Date & Time | The date and time | 4/15/2017 16:53:16
that the activity
occurred
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OTHER MANUALS AND SOFTWARE

Please visit us at: www.altus-inc.com/manuals to download

all operating and user manuals and to access the Central
Management Software.
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